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Where to Find Help When You Need It 

Student Computer Help Web Site 
The computer help web site for students provides information about the type of help you can 
get and locations where help is available. To find this information, look to: 
http://rohan.sdsu.edu/~students
 
Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative to 
provide all students, faculty, and staff with "baseline" access to information resources via 
networks, training in the uses of baseline hardware and software systems, and ongoing 
professional and technical support for utilization of computer resources at San Diego State 
University.  You can access the BATS Web Page by pointing your browser to: 
http://rohan.sdsu.edu/~bats/
 
Help in the Love Library Student Computing Lab 
The Student Computing Lab's purpose is to facilitate students in completing assigned class 
work, as well as provide assistance to students having computer problems relating to the 
Internet, Netscape, SPSS, File Transfers, PC Operating Systems, Microsoft Office Software 
and Business Databases. 
 
Location:  2nd floor of the Love Library building in LL-200 
Hours:  10:00am – midnight Sunday 
    7:00am – midnight Monday - Thursday 
    7:00am  –  6:00pm Friday 

10:00 am  –  6:00pm Saturday 
               
Help from the Student Computing Help Desk 
Phone:   594-3189 
Location: Love Library 220 
Hours:  8:00am – 4:30pm  Monday 
  8:00am – 4:30pm  Tuesday 

8:00am – 7:30pm  Wednesday 
8:00am – 7:30pm  Thursday 
8:00am – 4:30pm  Friday  

E-mail:  problems@rohan.sdsu.edu 
 

 

http://rohan.sdsu.edu/%7Estudents
http://rohan.sdsu.edu/%7Ebats/
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Presentation Skills 

This handout is to be used as a supplement while attending the Presentation Skills workshop taught as 
part of the BATS program at San Diego State University. The handout will follow along with the lesson 
and help you to review anything you have missed during the workshop. During the workshop you will 
learn tips on how to make an effective presentation to an audience.  
 
Microsoft PowerPoint has become the default tool for making presentations, and as such it will be 
referenced in this workshop as the expected form of communication you will be using 
 
The presentation tips portion will review the Keys to Effective Visual Presentations that include: 

• Arrangement 
• Communications 
• Organization 
• Creativity 

And we will discuss how to enhance your presentation my looking at the Conventions of Good 
Presentations which include: 

• Audience Analysis 
• Content 
• Formatting 
• Animation 

 
And finally we will discuss moving beyond just having presentations with bullet points, adding graphics, 
sound and video to make you presentations more effective and more memorable. 
  
The Fear of Public Speaking 

Jerry Seinfeld has a routine he does where he points out that in a list of top fears, public speaking was 
rated worse than death. His punch line is: This means to the average person, if you go to a funeral, 
you're better off in the casket than doing the eulogy.  
 
Glossophobia or speech anxiety is the fear of public speaking. The word glossophobia comes from the 
Greek γλῶσσα glōssa, meaning tongue, and φόβος phobos, fear or dread. Glossophobia may be a 
symptom of stage fright. Everyone experiences stage fright, speech anxiety, or talking terror. Surveys 
show that fear of speaking in front of groups is one of the greatest fears people have. Some surveys find 
people actually claiming that the thought of giving a speech is more frightening than falling off a cliff, 
financial difficulties, snakes, and even death.  
 
The following is a list of techniques people use for coping with their fear of public speaking:  

• Your audience understands your nervousness; they know what you are feeling and will forgive it; 
similarly they will forgive honest mistakes  

• Nervousness is usually invisible; most will not notice the small changes in your voice or 
occasional mistakes; most speakers who describe themselves as nervous appear confident and 
calm to the audience  

• Be yourself; let the real you come through; relax, practice some deep breathing techniques 
• Begin in your comfort zone; practice with friends; share your fears with friends  
• Check out the room first; check out the space, the equipment, the lights  
• Concentrate on the message  
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• Begin with a slow, well-prepared introduction; have a confident and clear conclusion  
• Most important: be prepared and practice  

 
The problem of poor communication is complex and cannot be solved by a single book, a course, a 
workshop, and certainly not by this short guide. 
 
If You Fail to Plan, then Plan to Fail 
 
Very few people can walk unprepared into a room full of people and give a presentation on a subject 
that they are experts in. In an academic situation you may have to make a presentation about a topic 
about which you are not an expert, in fact you may know little about the subject before your were 
assigned the project. Nevertheless, you will likely have to research the topic through textbooks, 
magazines, journals, or special interest publications. You will also likely find computerized data bases 
useful as sources of information. Subscription data bases such as LexisNexis, FirstSearch, or EbscoHost 
are some examples. Obviously the World Wide Web is a growing source of information. Librarians will 
assist you in your search. Luckily for you as students, most of these services are free through the SDSU 
library website: http://infodome.sdsu.edu/. 
 

Getting Started  

What is a presentation?  
In the broadest sense, it's every encounter you have with every person you ever meet.  
 
It's when you sit squirming in an interviewer's chair trying to be eloquent when you are asked why you 
left your last job.  
 
More specifically, however, here we are going to discuss the academic presentation. Whenever you are 
asked to appear in front of one or more people for the purpose of explaining, educating, convincing, or 
otherwise conveying information to them, you have a presentation.  
 
Compressed to its essence, a presentation consists of three basic elements: you, your audience, and your 
message.  To convey your message you have tools as your disposal. 
 
The central purpose of any presentation, written, oral or visual, is communication. To communicate 
effectively, you must state your facts in a simple, concise and interesting manner.   
 
The Use of Visuals 
 
It is proven that people learn more readily and retain more information when learning is reinforced by 
visualization. You can entertain, inform, excite and even shock an audience by the proper integration of 
visual images into virtually any exchange of information.   
 
Presentations which might normally be considered dull, or a chore to be avoided, can be transformed 
into exciting productions that grab the attention of the viewers.   
 
This kind of presentation maximizes the audience retention of the subject matter. The phrase "a picture 
is worth a thousand words" has existed since the New York Post discovered the value of visuals in the 
news business. This remains true to this day. Simple, clear, concise visual images, briskly paced and 
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sprinkled with attention-grabbing graphics will lend support to your spoken words. This leaves your 
audience with a positive attitude toward you and your presentation.  
 
Visuals in a presentation should be used in support of the spoken or written word, and not in lieu of it. A 
well-developed concept and effective script are the essential elements of any presentation. Regardless of 
their form, they should be the first and most important phase of its development. When the concept 
begins to take final form, the visuals are developed around it.   
 
This is not to imply that A-V design should be placed near the end of the project. You must begin 
mentally planning your visuals at the beginning of the design process. Hastily designed and produced 
visuals can doom a presentation (and a presenter,) where well planned and executed images add 
tremendous strength. Concepts that are difficult to grasp can be communicated quickly and easily 
through the intelligent use of visuals. This allows you the freedom to communicate more complex 
subject matter in a more efficient manner, adding support and impact to your script.   
 
Finally, your presentation should be entertaining. Leave the audience feeling better and more relaxed 
when they leave and that impression will carry over to both your subject matter and yourself.  
 
The Key Steps to an Effective Presentation 

1. Know Your Subject Matter  
While this first point may seem obvious, it is very important that you research every nuance of your 
subject. Read reports and look up information about the subject with the specific purpose of writing 
a presentation script. When examined in this light, new ideas and alternative ways of thinking often 
develop. The ability to present a subject with confidence directly affects your audience's impressions 
and will help keep their attention.  
 
This is especially important when giving a design presentation or proposal since you are in effect 
selling" your ideas to the audience. 
 

2. Know Your Audience (Audience Analysis) 
A small amount of research into the makeup of your audience will reap large benefits on 
presentation day. This information will drive many of your design decisions. 
 

3. Know Yourself (And Your Limits) 
We all must push our limits and willingly bite off more than we may be comfortable swallowing on 
occasion -- this is how we learn and grow.  
Knowing a few of your limits, however, might avert disaster, or at least embarrassment.  
Intimately related to Know Your Audience above, your 'limits' are just where you may or may not 
tread, depending on the makeup of your audience and your relationship with them. 
 
The use of humor can be very effective, and equally ineffective if used at the wrong time, in the 
wrong setting, or by the wrong person. Just because people laughed when Whoopee Goldberg said 
or did something doesn't mean you can pull it off. Jon Stewart, Jay Leno, David Letterman, and a 
host of others can get away with and even receive praise and applause for saying or doing things that 
would get you tarred, feathered, sued or booed by their respective audiences. 
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4. Develop A Theme 
All presentations, regardless of their complexity, are designed with a single purpose. Whether that 
purpose is to sell, educate, or for pure entertainment, state that purpose to your self at the beginning 
of the development process. Keep this purpose in mind always. 
 

5. Prepare Your Script 
The script does not necessarily have to be a work of literary excellence. For some, simple notes on  
3 x 5 file cards are sufficient. Other presenters and presentations require a carefully composed, 
professionally developed script. The exact form of the script depends on the formality of the 
presentation, the make up of the audience and who will be presenting it. Any presentation script, 
regardless of complexity should consist of the same four basic parts, an opening, body, summary and 
closing.  

• The Opening  
The opening of the presentation sets the stage for what is to follow. Participants are 
introduced and the purpose of the presentation is stated. You should also present a VERY 
BRIEF summary or outline of the points to be covered. This helps keep your audience 
oriented properly within the framework of your script.  

• The Body  
This is the part of the script in which the bulk of the subject matter is presented. The body 
of a long presentation should be separated into smaller, easily assimilated modules.  
Each module or sub-section should make a single point or convey one idea.  
These sub-sections should each have their own simple opening, body and summary.  

• The Summary 
This portion should be very brief and simple. Here is your chance to reinforce the central 
theme and purpose of your presentation. Briefly emphasize the key points and main ideas 
of your script in this section. 

     
There is an old axiom that says ... "Tell them what you are going to tell them, tell them, and then tell 
them what you told them." This pretty well sums it up. 
 
Question and answer sessions often follow a final summary and are very productive if managed 
properly. You should encourage questions from the audience if time or format permits, but be 
prepared to answer them. If you do not know the correct answer to a question, don't try to fake it. 
You should refer the question to someone who can answer it correctly or make a note to yourself to 
obtain the answer later. When you do, contact the person or persons who asked it as soon as 
possible.  

• The Closing 
In a well structured closing, points raised during the question and answer session (if any) 
are summarized and any handout material that was not required during the presentation 
is distributed. Handout material which emphasizes each key point or idea permits your 
audience to review the subject and assures that your words will remain fresh in their 
minds. Handout material should not be distributed before a presentation unless it is 
critical to the theme since it invariably leads to audience distraction.   

 
6. Select The Proper Visual Aids 

With the script developed and the audience analysis completed, this decision should be simple. A 
five minute presentation to a three person audience is probably best made with handout material 
alone, or even simple flip charts. Larger audiences might be effectively reached by using a few 
simple overhead transparencies. (yes, they still have their purpose). Most presentations to an entire 
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class in an academic setting will use a computer and a video data projector and probably be based in 
PowerPoint. Good presentation visuals, however, do not have to be expensive. When properly 
planned and produced, simple, well designed graphics add professionalism and impact to virtually 
any show. The proper use of text images, charts and graphs as well as the correct type of chart or 
graph to use in various circumstances will be discussed during the workshop. 
 

7. Prepare a Story Board 
A story board does not have to be complicated or time consuming to prepare. Its main purpose is to 
give a general view of the presentation and communicate the important items to whoever is creating 
and assembling the images.   
 
You can make your story board using file cards and post- it notes, or opt for a comprehensive color 
story board. During the story board phase you can rehearse the script and easily rearrange, revise, 
delete from and add to your presentation. When your story board reaches final form it becomes the 
finished draft for your presentation. This is one of the most important design tools used to produce 
your graphics.  
 
The final story board should consist of a sketch of each individual image, in sufficient detail to 
convey its approximate finished appearance.  
 

8. Produce the Visuals 
If the previous steps have been carefully followed, this can be the easiest part of preparing your 
presentation.   
 
With careful, timely planning, the only task remaining is mechanical process of production. The 
complete and accurate planning that you have done to this point assures a smooth production cycle 
without the need for unnecessary last minute changes. This is true whether you use Magic Markers 
to prepare flip charts on a newsprint pad or require a nine projector slide presentation with live 
video.   
 
Today's computer graphics products permit you to make changes and alterations that could not be 
accomplished using any other method of production. While last minute changes are possible, try to 
avoid them because you need to know your presentation well for the last step. 
 

9. Rehearse — Rehearse — Rehearse 
Your final script and outline or story board permit you to rehearse your presentation even before the 
visuals are completed. This assures that when your final images are prepared and ready, you will be 
as well.  The first time you do your presentation should NEVER be when you are being evaluated, 
because things go wrong at the most inopportune time, if you have rehearsed and know your 
presentation well, you will be able to improve if you have to without looking flusterd. 
 
If you'd like to really test your mettle, drag out the camcorder and tape your rehearsal. Just keep in 
mind, no one expects you to be Winston Churchill. 
 
When you look at yourself and think you look terrible, remember the episode of Friends where they 
were looking at an old video from high school of Monica who looked a little over weight: 

Monica: "Hey! The camera adds ten pounds!" 
Chandler: "So how many cameras were actually on you?" 
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In his 1994 book The Principles of Public Presentation, Isa Engleberg proposes 7P’s of public speaking. 
You might find these helpful. 

• Purpose 
Why are you speaking? What do you want audience members to know, think, believe, or do as a 
result of your presentation 

• People 
Who is your audience? How do the characteristics, skills, opinions, and behaviors of your 
audience affect your purpose 

• Place 
Why are you speaking to this group now and in this place? How can you plan and adapt to the 
logistics of this place. How can you use visual aids to help you achieve your purpose 

• Preparation  
Where and how can you find good ideas and information for your speech? How much and what 
kind of supporting materials do you need. 

• Planning  
Is there a natural order to the ideas and information you will use? What are the most effective 
ways to organize your speech in order to adapt it to the purpose, people, place, etc. 

• Personality 
How do you become associated with your message in a positive way? What can you do to 
demonstrate your competence, charisma, and character to the audience? 

• Performance 
What form of delivery is best suited to the purpose of your speech. What delivery techniques will 
make your presentation more effective. How should you practice? 
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Presentation Tools in PowerPoint: 
 

Animation  The animation capabilities of PowerPoint have been greatly enhanced. 
You may now animate objects on and off the screen, give an item 
emphasis and define its motion as it moves.  
On the Slide Show menu, select Custom Animation. 
The custom animation menu will appear in the task pane at the left of the 
screen. The menu is shown here with the submenus all shown: 
 
On the slide, select the text or object you 
want to animate. 
Click Add Effect, Next Modify the Effect. 
To start the animation by clicking the 
mouse or spacebar, select On Click. 
To start the animation automatically, click 
After Previous, and then enter the number 
of seconds you want to elapse between the 
previous animation and the current one. 
You can select settings for the particular 
animation you choose with the submenus, 
in this case Direction and Speed 
Repeat these steps for every object you 
want to animate. You can click the Play 
button to see how your animations work. 
 
Changing the emphasis of an item, allows 
you to change the font, the font size, the 
font style, and many others. 
 
You can define the motion path of an item 
under motion path. 
 
 
And you can now have an item exit the screen with creating a new slide 
by animating its exit. 
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Slide Transitions 

 

On the Slide Show menu, click Slide Transition. 
The transistions menu will appear in the task pane at the left of the 
screen.  
 
Select the transition you would like. 
Select the speed at which the transition occurs. 
If desired, in the Sound box, select the sound 
effect to accompany the transition effect. 
In the Advance section, select when to execute the 
transition, either on mouse click or automatically 
after xxx seconds. 
To apply the transition to the selected slide, click 
Apply. 
To apply the transition to all the slides, click 
Apply to All Slides. 
To view the transition(s), click Slide Show. 

Adding Images On the Insert menu, click Picture. You have several choices for the 
source of your picture; you can use the Clip-Art Library, a picture that is 
saved on your computer, a picture from your digital camera, or a scanned 
picture. 
 

Adding Sounds or 
Video 

On the Insert menu, click Movies and Sounds. You have several choices 
for the source of your sound or video. 

Adding Hyperlinks Select the item you want to link from, either text or a picture. On the 
Insert menu, click Hyperlink. Hyperlinks can be to website, or to file on 
the computer, for example if you create link to an Excel Spreadsheet. 
During the presentation, when you click on the link, it will open the 
spreadsheet in Excel. You could then use the spreadsheet as part of your 
presentation, and return to the same point in the presentation when you 
are done using the spreadsheet. 

Adding Page 
Numbers, Footers, 
etc. to All Slides 

On the View menu, click Header and Footer. 
To add the information to your slides, click the Slide tab. 
To add the information to notes pages and handouts, click the Notes and 
Handouts tab. 
Select the options you want. 
To add it to all slides in the presentation, click Apply to All. 
To add the information to only the current slide, click Apply. 
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Quick Keys 

 

Press To 

N, ENTER, PAGE DOWN, RIGHT ARROW, 
DOWN ARROW, or the SPACEBAR (or click 
the mouse) 

Perform the next animation or 
advance to the next slide 

P, PAGE UP, LEFT ARROW, UP ARROW, 
or BACKSPACE 

Perform the previous 
animation or return to the 
previous slide 

<number>+ENTER Go to slide <number> 

B or PERIOD Display a black screen, or 
return to the slide show from 
a black screen 

W or COMMA Display a white screen, or 
return to the slide show from 
a white screen 

S or PLUS SIGN Stop or restart an automatic 
slide show 

ESC, CTRL+BREAK, or HYPHEN End a slide show 

E Erase on-screen annotations 

H Go to next hidden slide 

Both mouse buttons for 2 seconds Return to the first slide 

CTRL+P Redisplay hidden pointer 
and/or change the pointer to 
a pen 

CTRL+A Redisplay hidden pointer 
and/or change the pointer to 
an arrow  

CTRL+H Hide the pointer and button 
immediately 

CTRL+U Hide the pointer and button in 
15 seconds 

SHIFT+F10 (or right-click) Display the shortcut menu 

TAB Go to the first or next 
hyperlink on a slide 

SHIFT+TAB Go to the last or previous 
hyperlink on a slide 

ENTER while a hyperlink is selected Perform the "mouse click" 
behavior of the selected 
hyperlink 

SHIFT+ENTER while a hyperlink is selected Perform the "mouse over" 
behavior of the selected 
hyperlink 
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Specify a slide to 
be hidden during a 
slide show 

In the normal view, click Hide Slide on the Slide Show menu. 
In slide sorter view, select the slide you want to hide, and then click Hide 
Slide        A "null" sign  appears over the slide number. 
 

Display a hidden 
slide during a slide 
show 

Right-click the slide that precedes the hidden one, point to Go, and then 
click Hidden Slide. The command will be available only if the next slide 
is hidden. 
Right-click any slide in a presentation, point to Go, click Slide 
Navigator, and then double-click the slide you want. Numbers in 
parentheses designate hidden slides. 
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Keys to Effective Presentations 

Arrangement • Alignment 
• Proximity 
• Contrast 
• Repetition 

 
Communication • Speak in a Loud Clear Voice 

• Be approachable 
• Make eye contact with the audience 

 
Organization • Be efficient with the time allowed 

• Lay your topics out in a logical order 
• Have an introduction and a summary 

 
Creativity • Welcome new ideas 

• Have a positive outlook 
• Don’t be afraid to experiment 

 
Conventions of Effective Presentations 

Audience Analysis • Know your audience before giving a presentation; let what you 
know about your audience guide your design choices. 

• Use terms your audience will understand, take time to introduce 
new terms or concepts. 

 
Content Issues • Cover only one main topic per slide. 

• Use no more than 6-7 lines of text per slide (not including title). 
• Each line should be no more than 10 words in length. 
• Allow for "white" space on each slide. 
• Do not read slides verbatim. 
• Select content appropriate graphics. 

 

Formatting Issues • Font size should be at least 24 point for titles, 18 point for text. 
• Select color schemes that audience can identify with. 
• Put common text and graphics on slide master. 
• Limit use of the color red. 

 

Animation 
Considerations 
 

• Limit animation and transition effects to no more than 1 or 2 
different types per presentation. 

• Understand that the use of animation increases the length of the 
presentation. 

• Select audience and content appropriate sounds and movies. 
• When in doubt of the speed of the computer, select the fastest 

animation speed. 
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Conclusion 

This workshop will not remove all of your fears of public speaking, or make you a dynamic speaker in 
only 2 hours. But a prepared speaker will always do better than an unprepared one. 
 
Always remember to properly prepare and then practice your presentation, if you have any questions 
about PowerPoint, contact Charles Hurley at (619) 594-0483 or churley@mail.sdsu.edu 
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